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Lab 2d 

Torsional Second-Order System 
 

OBJECTIVE 

 

Warning: though the experiment has educational objectives (to learn about boiling heat 

transfer, etc.), these should not be included in your report. 

 

- To measure and investigate the dynamic characteristics of a Torsional Second-Order 

system. 

- To measure the inertia, spring, and damping constants of the plant. 

EQUIPMENT 
Name Model S/N 

Experimental Control System                205  

DSP Based Controller / Data 
Acquisition Board 
Input /Output Electronics 
Electromechanical Plant 
System Interface Software (Executive 

Program) 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1: The Model 205 

Torsional  

Spring / Inertia Apparatus 
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The experimental system is comprised of the three subsystems. The first of these is 
the electromechanical plant which consists of the torsion mechanism, its actuator and 
sensors. The design features a brushless DC servo motor, high resolution encoders, 
adjustable inertias, and reconfigurable plant type. 
 
The next subsystem is the real-time controller unit which contains the digital signal 
processor (DSP) based real-time controller, servo/actuator interfaces, servo 
amplifiers, and auxiliary power supplies. The DSP is capable of executing control 
laws at high sampling rates allowing the implementation to be modeled as continuous 
or discrete time. The controller also interprets trajectory commands and supports 
such functions as data acquisition, trajectory generation, and system health and safety 
checks. A logic gate array performs motor commutation and encoder pulse decoding. 
Two optional auxiliary digital-to-analog converters (DAC's) provide for real-time 
analog signal measurement. This controller is representative of modern industrial 
control implementation. 
 
The third subsystem is the executive program which runs on a PC under Windows 
XP operating system. This menu-driven program is the user's interface to the system 
and supports controller specification, trajectory definition, data acquisition, plotting, 
system execution commands, and more. Controllers may assume a broad range of 
selectable block diagram topologies and dynamic order. The interface supports an 
assortment of features which provide a friendly yet powerful experimental 
environment. 
 
REQUIRED READING 

 

Reference [1] for the theory. See Attachment A for safety precautions. See Attachment B and 

Appendix C for ECP Executive Program Demonstration and unit description. 

 

PRELAB QUESTION 

 

1- What is damped frequency? 

2- What is natural frequency? 

3- What is damping ratio? 

4- What is effective spring constant? 

5- Read carefully the instructions in this write-up and describe how you will perform 

your measurements to obtain errors on the system parameters (spring constants and 

Damping ratio), as well as natural frequencies of the systems. 

PROCEDURE 

1. For Model 205a, clamp the center disk to put the mechanism in the 

configuration shown in Figure 1a using the 1/4" bolt, square nut, and clamp 

spacer.  Only light torque on the bolt is necessary.  
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Figure 2  Configurations For Plant Identification (Model 205a shown) 

 

2. Secure four 500g masses on the upper and lower disks as shown in the 

figure.  Verify that the masses are secured and that each is at a center 

distance of 9.0 cm (outermost ring) from the shaft center-line. 

3. With the controller powered up, enter the Control Algorithm box via the Set-

up menu and set Ts = 0.00442.  Enter the Command menu, go to Trajectory 

and select Step, Set-up.  Select Open Loop Step and input a step size of 0 

(zero), a duration of 4000 ms and 1 repetition.  Exit to the Background 

Screen by consecutively selecting OK.  This puts the controller board in a 

mode for acquiring 8 sec of data on command but without driving the 

actuator.  This procedure may be repeated and the duration adjusted to vary 

the data acquisition period. 
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4. Go to Set up Data Acquisition in the Data menu and select Encoder #1 and 

Encoder #3 as data to acquire and specify data sampling every 2 (two) servo 

cycles, i.e. every 2 Ts's.  Select OK to exit.  Select Zero Position from the 

Utility menu to zero the encoder positions. 

5. Select Execute from the Command menu.  Prepare to manually displace the 

upper disk approximately 20 deg.  Exercise caution in displacing the inertia 

disk; displacements beyond 40 deg may damage and possibly break the 

flexible drive shaft.  (Displacements beyond 25 deg will trip a software 

limit which disables the controller indicated by "Limit Exceeded" in the 

Controller Status box in the Background Screen.  To reset, simply reselect 

Execute from the Command menu.)  With the upper disk displaced 

approximately 20 deg (≤1000 encoder counts as read on the Background 

Screen display) in either direction, select Run from the Execute box and 

release the disk approximately 1 second later.  The disk will oscillate and 

slowly attenuate while encoder data is collected to record this response.  

Select OK after data is uploaded. 

6. Select Set-up Plot from the Plotting menu and choose Encoder #3 position; then 

select Plot Data from the Plotting menu.  You will see the upper disk time 

response.   

7. Choose several consecutive cycles (say 5 to 10) in the amplitude range 

between 100 and 1000 counts (This is representative of oscillation 

amplitudes during later closed loop control maneuvers.  Much smaller 

amplitude responses become dominated by nonlinear friction effects and do 

not reflect the salient system dynamics)  Divide the number of cycles by the 

time taken to complete them being sure to take beginning and end times 

from the same phase of the respective harmonic cycles. 1   Convert the 

resulting frequency in Hz to radians/sec.  This damped frequency, d, 

approximates the natural frequency, n, according to: 

   

(1)

 

 where the "d31" subscript denotes disk #3, trial #1.  (Close the graph 

window by clicking on the left button in the upper right hand corner of the 

graph.  This will collapse the graph to icon form where it may later be 

brought back up by double-clicking on it.) 

8. Remove the four masses from the third (upper) disk and repeat Steps 5 

through 7 to obtain nd32 for the unloaded disk.  If necessary, repeat Step 3 

to reduce the execution (data sampling) duration. 

                                                 
1You may “zoom” the plot via Ax is Sca l ing  for more precise measurement in various areas.  For an even greater 

precision, the data may be examined in tabular numerical form – see Ex por t  Raw  Dat a, Section 2.1.7.3 of 

manual. 

 n d 3 1   =   
 d d 3 1 

1 -  d 3 1 
2 

  =    d d 3 1           ( f o r   s m a l l    d 3 ) 
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2
cylmasseach R*mass + J = J

 

)R*mass + radius*mass*(0.5*4 = J 22
m 

9. Measure the reduction from the initial cycle amplitude Xo to the last cycle 

amplitude Xn for the n cycles measured in Step #8.  Using relationships 

associated with the logarithmic decrement: 

  

(2) 

 find the damping ratio d32 and show that for this small value the 

approximations of Eq's (1 and 2) are valid. 

10. Repeat Steps 5 through 9 for the lower disk, disk #1.  Here in Step 6 you 

will need to remove Encoder #3 position and add Encoder #1 position to the 

plot set-up.  Hence obtain nd11 , nd12 and d12.  How does this damping 

ratio compare with that for the upper disk? 

11. Use the following information pertaining to each mass piece to calculate the 

portion of each disk's inertia attributable to the four masses for the "d31" 

and "d11" cases. 

 mass (incl. bolt & nut) = 500g (± 5g) 

diameter = 5.00 cm (± 0.02 cm) 

 The moment of inertial of each cylindrical mass about its axis is Jcyl = 

0.5*mass*radius
2
 where radius is the cylinder’s radius and mass is a single 

piece’s mass. From the parallel axis theorem, the moment of inertial of the 

mass rotating about an axis displaced from its own axis by a distance R is  

  

 So Jm for the four masses combined would be 

 

 if mass = 500 g , radius = 0.025 cm, and R = 0.09 cm then Jm = 0.016825 

kg-m
2
. 

 

12. Using this inertia Jm (i.e. that associated with the four masses combined), 

use the following relationships to solve for the unloaded disk inertia Jd3, 

and upper torsional shaft spring kd3. 

  kd3/(Jm+Jd3) = (nd31)
2  (3) 

  kd3/Jd3 = (nd32)
2  (4) 

 Find the damping coefficient cd3 by equating the first order terms in the 

equation form: 

  s2 + 2ns + n
2 = s2 + c/Js + k/J (5) 

 d 3 2 

1 -  d 3 2 
2 

  =   1 
2  n 

  l n 
X o 
X n 

            d 3 2   =   1 
2  n 

  l n 
X o 
X n 

          ( f o r   s m a l l    d 3 2 ) 
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 Repeat this for the lower unloaded disk inertia (this includes the reflected 

inertias of the motor, belt, and pulleys), spring and damping Jd1, cd1 and kd1 

respectively.2   

 

Now all dynamic parameters have been identified!  Values for J1 and J2 for any configuration 

of masses may be found by adding the calculated inertia contribution of the masses to that of 

the unloaded disk3.   

 

 

Day 2 Procedure 

 

1) Read and follow the safety precautions in Attachment A at the end of this write-up. 

Note: All users must read and understand Attachment A (Ecp Manual Section 2.3, 

Safety) before performing any procedures described in this chapter. 

 

2) Read through the unit description in Appendix C if you have not done this already. 

 

3) Work through the ECP Executive Program Demonstration in Attachment B at the 

end of this writeup.  However, instead of using the “default.cfg” in the handout use 

the one created for this lab, “lab2d_default.cfg”.  Go through the procedures in 

Attachment B; it uses no masses on the disks and all disks are free to rotate so 

remove any bolts fixing the discs. Familiarize yourself with the operation of the 

ECP Executive program by completing the demonstration of the ECP Executive 

program.  Note also the control settings may be different than the Attachment B 

values (the gains discussed in step 2 in Attachment B); record these in your 

logbooks. At the end of the demo you should have a good understanding of: 

loading configuration files, using the trajectory settings, executing a trajectory, and 

plotting data. 

 

4) Use the "Export Raw Data" function under the "Data" menu to export acquired 

data, and then bring the data into the Excel program. This will be useful in storing 

data if you need.  Learn how to export and plot data.  Consult the TA or manual 

for assistance if needed. 

 

5) Abort the control algorithm, just in case it is still active, since you should not 

added or remove masses with the control program activated. Measure the mass of 

two masses and position them 9 cm. from the shaft center line on encoder plate 2.  

Measure their distance to have an accurate number for this distance and an 

uncertainty estimate.  Fix or lock disk 3 to prevent its rotational movement using 

the spacer, bolt and nut. 

 

                                                 
2Steps 11 and 12 may be done later, away from the laboratory, if necessary. 
3In plant configurations where a disk is used in the center location, the inertia and damping parameters may be 

assumed to be the same as for the upper disk.   
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6) Using what you have learned in step 3) above, load the configuration file 

"lab2d_step.cfg". Go to the algorithm settings and record them. Go to the 

trajectory settings menu and record them. Return to the Setup Control Algorithm 

menu and implement the algorithm. Setup a plot of the encoder 1 and 2 position 

output. Execute the trajectory. Observe the plot of the data and do not delete this 

plot. Export the data to a file and determine the frequency of the oscillations at 

encoder 2.  Using Equation (6) determine the effective spring constant keffective for 

both shafts attached in this configuration  

         keffective/(Jm+Jd) = (n)2  (6) 

 

where Jm is for two masses (about 0.0084 kg-m
2
), for Jd use the inertia found for 

disk 3 in Day 1 for disk 2, and use the measured natural frequency for n.  Drive 

the system again using the configuration file “lab2d_step.cfg”, plot the data from 

the encoders 2 to determine the frequency of the oscillations determining again.  

Determine the torsional spring constant parameter value for the shafts again.  

Compare this spring constant to what you found for the individual shafts on day 1 

(one between encoders 1 and 2, and the other between encoders 2 and 3). Repeat 

this several times and estimate a repeatability error for keffective. 

 

7) Press the "Abort Control" button. Move the masses to a position 5 cm from the 

shaft centerline. Implement the algorithm/configuration file "lab2d_step.cfg" 

again, and execute the trajectory. Export the data to a file and determine and 

record the natural frequency. Determine the torsional spring constant parameter 

value keffective once more from the measured natural frequency and the new 

rotational inertia at the 5 cm position.  Repeat this several times and estimate a 

repeatability error. Does the value of keffective change, and why should it or should it 

not change?   

 

8) Press the "Abort Control" button. Add two more masses to the remaining slots 

on the plate of encoder 2.  Place all masses 9 cm from the shaft centerline also.  

Load the configuration file "lab2d_step.cfg".  Implement the algorithm and 

execute the trajectory again. Export the data to a file and determine the natural 

frequency. Find the torsional spring constant parameter value again from the 

measured natural frequency.  Repeat this several times and estimate a repeatability 

error. Does the value of keffective change from that in step 6) or 7), and why should it 

or should it not change?   

 

9) This step can be done outside of lab, if desired.  Report on and discuss the effect of 

mass and radial position on natural frequency and polar moment of inertial for the 

torsional vibration system.  Determine whether the dependence is linear or non-

linear.  Plot the natural frequency and polar moment of inertia versus mass and 

position from shaft centerline.  Is the damping Coulomb- or viscous-type 

damping?   
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10) Press the "Abort Control" button. Load the configuration file 

"lab2d_sine_low.cfg". Record the control and trajectory settings. Implement the 

algorithm and execute the sine input trajectory. Observe the data plot of the two 

encoder positions. Is the system response at encoder 2 over- or under-damped 

relative to the motion input at encoder 1?  Record the amplitude and frequency 

data, and note the steady state time-delay between the two encoders.  This time 

delay can be used to determine the phase shift. 

 

11) Repeat the steps in 10) by loading, and running each of the following 

configuration files:  

"lab2d_sine_transmission.cfg" 

"lab2d_sine_resonance.cfg" 

"lab2d_sinefilter1.cfg" 

"lab2d_sinefilter2.cfg".   

 

Record the amplitude and frequency data for each file run, and note the steady 

state time-delay between the two encoders for each case.  This time delay can be 

used to determine the phase shift in the next step that you will complete outside 

the lab. 

12) Outside of lab, make your own frequency response plots like Figure 3.16 and 3.17 

in your text for Magnitude ratio and Phase shift, respectively (see plots repeated 

below). However, your plots should have one theoretical curve corresponding the 

damping ratio you estimate best fits all of your data, and five experimental data 

points corresponding to the five frequency ratios (ω/ωn) executed in steps 10) and 

11).  Use ωn determine for the four masses on plate 2 in step 8). 
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Appendix A: Safety 

 

The following are safety features of the system and cautions regarding its operation.  This 

section must be read and understood by all users prior to operating the system.  If any 

material in this section is not clear to the reader, contact ECP for clarification before 

operating the system. 

 

 

Important Notice: In the event of an emergency, control effort should be 

immediately discontinued by pressing the red "OFF" button 

on front of the control box.   

 

A.1 Hardware  

 

A relay circuit is installed within the Control Box which automatically turns off power to the 

Box whenever the real-time Controller (within the PC) is turned on or off.  Thus for the PC 

bus version4 of the real-time Controller the user should turn on the computer prior to pressing 

on the black ON switch.  This feature is implemented to prevent uncontrolled motor response 

during the transient power on/off periods.   The power to the Control Box may be turned off 

at any time by pressing the red OFF switch.   

 

Although not recommended, it will not damage the hardware to apply power to the Control-

Box even when the PC is turned off.   However, doing so does not result in motor activation 

as the motor current amplifier will be disabled.  The amplifier enable signal input to the 

Control Box is connected to the real-time Controller via the 60-pin flat ribbon cable.  This 

input operates in a normally closed mode.  When power to the real-time Controller is off, this 

input becomes open which in turn disables the motor amplifier. 

 

The recommended procedure for start up is as follows: 

 

First : Turn on the PC with the real-time Controller installed in it. 

Second: Turn on the power to Control Box (press on the black switch). 

 

 

The recommended shut down procedure is: 

 

First: Turn off the power to the Control Box. 

Second: Turn off the PC.. 

 

FUSES: There are two 3.0A 120V slow blow fuses within the Control Box.  One of them is 

housed at the back of the Control Box next to the power cord plug.  The second one is inside 

the box next to the large blue colored capacitor.   

                                                 
4The majority of this section pertains to the PC bus installation of the real-time controller.  For the controller 

box/RS-232 version, the control box should generally be powered on before entering the executive software. 
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A.2 Software  

 

The Limit Exceeded indicator of the Controller Status display indicates either one or more of the 

following conditions have occurred: 

 Over speed of the motor 

 Excessive deflection (twisting) of the torsion shaft 

 Excessive drive motor power 

 

The real-time Controller continuously monitors the above limiting conditions in its 

background routine (intervals of time in-between higher priority tasks).  When one if these 

conditions occurs, the real-time Controller opens up the control loop with a zero torque 

command sent to the actuator.  The Limit Exceeded indicator stays on until a new set of 

(stabilizing) control gains are downloaded to the real-time Controller via the Implement 

Algorithm button of the Setup Control Algorithm dialog box, or a new trajectory is executed via 

the Command menu.  Obviously  the new trajectory must have parameters that do not cause 

the Limit Exceeded condition. 

 

The Limit Exceeded indicator of the Disturbance Motor Status display indicates either one or 

both of the following conditions have occurred: 

 Over speed of the disturbance motor. 

 Excessive disturbance motor power 

 

Also included is a watch-dog timer.  This subsystem provides a fail-safe shutdown to guard 

against software malfunction and under-voltage conditions.  The use of the watch-dog timer 

is transparent to the user.  This shutdown condition turns on the red LED on the real-time 

Controller card, and will cause the control box to power down automatically.  You may need 

to cycle the power to the PC in order to reinitialize the real-time Controller should a watch-

dog timer shutdown occur. 

 

 

 

A.3 Safety Checking The Controller 

 

While it should generally be avoided, in some cases it is instructive or necessary to manually 

contact the mechanism when a controller is active.  This should always be done with caution 

and never in such a way that clothing or hair may be caught in the apparatus.  By staying 

clear of the mechanism when it is moving or when a trajectory has been commanded, the risk 

of injury is greatly reduced.  Being motionless, however, is not sufficient to assure the system 

is safe to contact.  In some cases an unstable controller may have been implemented but the 

system may remains motionless until perturbed – then it could react violently.   
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In order to eliminate the risk of injury in such an event, you should always safety check the 

controller prior to physically contacting the system.  This is done by lightly grasping a slender, 

light object with no sharp edges (e.g. a ruler without sharp edges or an unsharpened pencil) 

and using it to slowly move either the load or drive disk from side to side.  Keep hands clear 

of the mechanism while doing this and apply only light force to the disk.  If the disk does not 

spin up or oscillate then it may be manually contacted – but with caution.  This procedure 

must be repeated whenever any user interaction with the system occurs (either via the 

Executive Program or the Controller Box) if the mechanism is to be physically contacted 

again.  

 

 

A.4 Warnings  

 

WARNING #1: Stay clear of and do not touch any part of the mechanism while it is 

moving, while a trajectory has been commanded (via Execute, Command menu), or before 

the active controller has been safety checked – see Section A.3.   

 

WARNING #2: The following apply at all times except when motor drive power is 

disconnected (consult ECP if uncertain as to how to disconnect drive power):  

a) Stay clear of the mechanism while wearing loose clothing (e.g. ties, scarves and 

loose sleeves) and when hair is not kept close to the head. 

b) Keep head and face well clear of the mechanism. 

 

WARNING #3: Verify that the masses and inertia disks are secured prior to 

powering up the Control Box or transporting the mechanism. 

 

WARNING #4: Do not take the cover off or physically touch the interior of the 

Control Box unless its power cord is unplugged (first press the "Off" button on the 

front panel) and the PC is unpowered or disconnected. 

 

WARNING #5: The power cord must be removed from the Control box prior to the 

replacement of any fuses. 
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Attachment B: Demonstration of ECP Executive Program 

 

This section walks the user through the functions of the system.  By following the instructions 

below you will actually implement a controller, maneuver the system through various 

trajectories, and acquire and plot data.  

Step 1: Loading A Configuration File.  With the power to the Control box turned off, 

enter the ECP Executive program.  You should see the Background Display.  Turn 

on power to the Control Box (press on the black button).  Now enter the File menu, 

choose Load Setting and select the file default.cfg.  In fact, it would have been 

loaded into the Executive automatically upon startup.  This particular 

default.cfg file contains the controller gain parameters and other trajectory, 

data gathering and plotting parameters specifically saved for the activities within 

this section. 

Note again that this file has been created to operate with a plant with three disks with no extra 

(brass) weights attached.   

Step 2: Implementing The Controller.  Now enter the Setup menu and choose Setup 

Control Algorithm.  You should see the sampling time Ts = 0.004420 seconds, Discrete 

Time control type, and State Feedback control selected.  Select Setup Algorithm; you 

should see for Model 205a the following gains: kpf=0.935, k1=1.0074, k2=4.9957, k3=-

0.07867, k4= 5.27106, k5=0.00533 and k6=5.510.  This controller was designed using 

linear quadratic regulator (LQR) synthesis techniques with all error weighting on 

encoder 3. 

 Exit this dialog box and select Implement Algorithm.  The control law is now 

downloaded to the real-time Controller.  Use a ruler to verify that control action is in 

effect on the lower disk If you do not notice any motor power, click on the 

Implement Algorithm button again until you notice the servo loop closed.  Now select 

Upload Algorithm, then General Form and Setup Algorithm.  You should see the general 

form of the real-time algorithm with some non-zero coefficients.  These coefficients 

correspond to the state feedback gains mapped to a form suitable for execution via 

the general form algorithm.  Note that the general form algorithm is the only 

structure that actually runs in real-time.  All other structures (e.g. PID, dynamic 

filters, etc.) are translated to the general form by the Executive prior to 

implementation. 

Step 3: Setting Up Data Acquisition.  Enter the Data menu and select Setup Data Acquisition.  

In this box make sure that the following four items are selected: Commanded 

Position and Encoders 1,2, & 3.  Data sample period should be 2 which means that 

data will be collected every second servo cycle (in this case every 

2*0.00442=0.00884 seconds).  
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Step 4: Executing A Step Input Trajectory & Plotting.  Enter the Command menu and 

select Trajectory.  In this box select Step and then Setup.  You should see step size = 

1000, dwell time =1000 ms and no. of repetitions = 1.  If not, change the values to 

correspond to this parameter set.  Exit this box and go to the Command menu.  This 

time select Execute and with the Sample Data check box checked run the trajectory.  

You should have noticed a step move of 1000 counts, a dwell of 1 second and a 

return step move.  Wait for the data to be uploaded from the real-time Controller to 

the Executive program running on the PC.  Now enter the Plotting menu and choose 

Setup Plot.  Select Encoder 3 and Commanded Position for plotting (left axis) and 

select Plot Data.   

 You should see a plot similar to the one shown in Figure 5.  Replace Encoder 3 with 

2 via the Setup Plot box and then with Encoder 1, plotting the data each time.  

Similar plots to the ones shown in Figures 6 and 7 should be seen. Note that all plot 

screens may be repositioned by dragging the plot frame bar using the mouse.  A plot 

screen  may be minimized or "shrunk" by clicking on the left most button on the top 

right hand corner.  By double clicking on a minimized plot screen it may be 

expanded again.  In general, to limit the program memory usage, one should avoid 

minimizing more than 8 to 10 plot screens on the Background screen.  It is best to 

close unwanted plot screens rather than minimize them.  You can re-size the plots 

using the cursor to "drag" any edge of the plot frame (position cursor at corner and 

begin "dragging" when cursor becomes double arrow).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5 Step Response at Encoder 3 
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Figure 6 Step Response at Encoder 2 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7 Step Response at Encoder 1 
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Appendix C: Electromechanical Plant 

 

C.1 Design Description 

The plant, shown in Figure 8, three (Model 205a) disks supported by a torsionally flexible 

shaft which is suspended vertically on anti-friction ball bearings.  The shaft is driven by a 

brushless servo motor connected via a rigid belt (negligible tensile flexibility) and pulley 

system with a 3:1 speed reduction ratio.  As shown in Figure 8 there is an encoder at each 

disk location. An encoder located on the base of the shaft measures the angular displacement, 

1 of the first disk, J1.  The second and third disk is connected to its encoder by a rigid belt / 

pulley with a 1:1 speed ratio.   

Figure 9 also shows the variety of plant types that are supported by each model. Mathematical 

modeling and parameter identification of these plants are given in the Unit Manual, Chapters 

5 and 6. 
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Figure 8  Torsion Spring / Inertia Apparatus 
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C.2 Changing Plant Configurations and Parameter Values 

As shown in Figure 9, the plant may be placed in a variety of free and clamped configurations 

with 1, 2, and 3 (Model 205a) degrees of freedom (DOF).  Changing configurations often 

requires removing or replacing inertia disks.  It is important to keep each pair of half-disks 

together in matched sets (see inscribed letters on disk edges).  By aligning the concentric 

markings, the proper relative alignment of the two halves is assured.  For operating safety, be 

sure to firmly tighten (but not excessively so) the bolts that fasten the disks to the shaft 

clamps.   

The user may change inertia values by changing the number of masses and/or their location 

on a given disk.  Figure 10 gives instructions for physically changing inertias. 

 

Hub Split Line

Secure masses by tightening screw.  Loosen
and slide to relocate.

Concentric rings @ r = 2.0 to 9.0 cm in 1 cm
intervals to assist in mass c.g. measurement.
(Measure to edge of 5.00 cm dia mass)

All masses must be concentrically located
(within ± 1 mm) prior to operation.

If only two masses are used, they must be
located along the hub split line.

500 ± 1 gr
(incl bolt & nut)

Disk Mass

Flat side of square
nut must face upward

Disk Plate

Each disk may have four, two or zero masses
only.  One or three masses will imbalance disk.

 

Figure 10  Guidelines For Changing Or Adjusting Disk Masses 

 

The user should verify that the disks, belts, and pulleys are properly aligned and secured and 

rotate freely prior to operation.   

 


